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The Mverify Marine Verification Program - Version 2.1
1) Introduction

The Mverify Marine Verification Program was created to fill the void for marine forecast
verification and also to aid forecasters by providing detailed access and interpretation of
marine data, forecast performance and guidance performance. Graphical and tabular data
listings, as well as statistical data, combined with flexible data selections options create a
wide range of possible uses by forecasters.

The Mverify Marine Verification Program consists of two programs: one of which acts to
collect data and maintain three databases, and a Graphical User Interface (GUI). Both of
these programs read a localization file which has a variety of configurable parameters to
suit each office.

This new version 2.1 has the following improvements over version 2.0:

- Added the ability for the Mverify GUI to handle the MRPGLW guidance data, which is
for the Great Lakes area. This requires new localization data to be entered in the
Mverify localization file.

- Added horizontal lines to the graph displays in order to make it easier to determine the
values on the plots. Thanks to Jack Settelmaier (SOO-EY W) for this suggestion.

- Added labels to values in the graph displays (which may be toggled on/off with the right
mouse button) so that the exact value may be displayed. Thanks to Joe Maniscalco
(Festr-MOB) for this suggestion. The number of labels to be displayed is a new adaptable
parameter in the Mverify localization file, and can also be changed temporarily through
the “Options” menu.

- The “Adaptable parameters used for these calculations” table now appears at the end of
the “Winds and Seas Only” statistics listing.

- Fixed a minor error which did not properly decode “TS” into “Tropical Strm” or “HR”
into “Hurricane Wng” in the second period of the Forecast data listing display. This did
not affect any other portion of the program other than this display.

- Fixed a possible error in the “Detailed Advisory Verification” column for “SCw” which
may display a negative number of observations. This would occur if the number of
observations with seas satisfying the criteria was greater than the number with observed
winds satisfying the criteria. In this case, the number of observations for the observed
winds would be negative, although the absolute value was correct. This did not affect any
statistical calculations and only affected the display in this column.

- Added vertical gust arrows for observed wind speed data to “Forecast vs. Guidance and
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Observed” and “Forecast vs. Observed” graphs.

- Mverify will now allow for missing localization data for either BuoyName or
CmanName in the Mverify localization file. This will allow those offices with just C-
MAN or just Buoy data to operate Mverify for just those stations.

- Optimized the tcl/tk coding which increase the processing speed for the Mverify 2.1.tcl
program as a whole by about 35%, or as follows for each function:

Listing Observed Data 25% faster
Listing Forecast Data 40% faster
Listing Guidance Data 40% faster
Graphing Observed Data 45% faster
Listing of Forecast vs. Observed 35% faster
Listing of Forecast vs. Guidance 35% faster
Listing of Forecast vs. Observed and Guidance 65% faster
Graphing of Forecast vs. Observed 25% faster
Graphing of Forecast vs. Guidance 45% faster
Graphing of Forecast vs. Observed and Guidance = 20% faster
Statistics (Winds/Seas Only) 35% faster
Statistics (Advisories Only) 40% faster
Statistics (Winds/Seas and Advisories) 40% faster
Detailed Advisory Verification 15% faster

- Removed checking for missing (9999) guidance wind data from tabular listings so that
guidance locations that contain missing wind information in some periods but not all can
at least be displayed. Also, limited error checking of guidance data used in graphical
displays to only those periods (in the guidance data) displayed. This will allow for some
guidance locations to have data now appear in tabular listings as well as graphical listings
that did not appear before. Full checking for missing wind information does continue for
the statistical processing, where missing wind information would contaminate the results.

2) Mverify Menus

The Mverify GUI has 6 menus: “Data”, “Analysis”, “Statistics”, “Options”, “Print”,
“Help”, and an “Exit” button. The most important menu of all is the “Options” menu,
which allows for powerful data selection parameters. Note that while some error
checking was performed by the Mverify data collection program (Mverify.perl) while
collecting the data, additional error checking is performed by the Mverify GUI to ensure
robust statistical results and data displays. These additional checks are an effort to
eliminate products that have been incorrectly coded or formatted or otherwise garbled. A
new entry under the “Options” menu entitled “Data Quality Control” allows for the
display of any data that was rejected by the Mverify GUIL. Unless otherwise noted, all
data will be in the following format:



- The date is in the format MM/DD/YY

- Wind direction (WD) is in tens of degrees

- Sustained wind (WS) and gust (Gst) are in knots

- Air (T), dew point (Td) and water temperature (Wt) are in degrees Fahrenheit
- Sea height (H) is in feet

- Sea period (P) is in minutes

- Pressure (Pres) and Pressure Tendency (Ptend) are in millibars

- Pressure Tendency is over 3 hours

- Tide levels (Tide) are Mean Low Low Water and measured in feet
- Visibility (Vsby) is in miles

- Missing data is displayed as “M”

A) “Data” Menu

This menu is for the display of the collected observed, forecast and guidance data,
either in a list format or a graph. More information about the data used in Mverify
can be found in section 3, “Data Used in Mverify.” The “List Observed Data”
submenu cascades to a selection for either C-MAN or Buoy Stations, with
selections for each cascading from each of these. The “C-MAN Stations” menu
and each C-MAN station is colored blue, while the “Buoy Stations” menu and
each Buoy station are colored green. This is to aid in traversing the menus.
Clicking on a station will produce a listing of the decoded data for that station.

The “List Forecast Data” submenu cascades to a listing of the stations contained
in the MVF product(s). Clicking on one of these will produce a listing of the
decoded forecast data. The “List Guidance Data” submenu cascades to a listing of
the guidance stations from the MRP product(s). Clicking on one of these
produces a listing of the decoded guidance data, for all eight periods.

The “Graph Observed Data” submenu cascades to a selection for “C-MAN
Stations” and “Buoy Stations”, with the same color format as for “List Observed
Data.” Clicking on one of these points will produce six graphs. Note: many
different combinations of plots can be created by toggling on or off the buttons for
each of the plots found at the bottom of the window and then clicking on the
“Redraw” button. For each plotted line, clicking with the left mouse button on the
legend or legend line will toggle that particular line on and off. If the number of
plotted data are less than the maximum allowed for labels, then labels will be
plotted at each data point. These labels can be toggled on and off by clicking with
the right mouse button on the legend or legend line for the line in question. An
information box is included at the bottom of the window, just to the left of the
“Redraw” button. This information box will indicate the total number of data
displayed, and the maximum allowed number for labels, per the
MaxPlottedValues setting in the Mverify localization file, or the current setting
for this value from the “Options > Maximum Number of Labels” menu. The
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following is a description of each plot produced.

a) Wind Plot - Wind direction is plotted in blue, with wind speed as orange, and
gusts in red as vertical arrows.

b) Temperature Plot - Air temperature is plotted in red, with dew point in green,
and water temperature in blue.

c¢) Sea Plot - Sea height is plotted in brown with sea period plotted as orange.
d) Pressure Plot - Pressure is plotted as a red-brown line.
e) Tide Plot - Tide is also plotted as a red-brown line.

f) Visibility Plot - Visibility is plotted as an orange line.

B) “Analysis” Menu

This menu is for the display of combinations of the observed, forecast and
guidance data. For all of these, the “Graph Comparison” option will produce a
display of six plots (depending on menu selection). As in the “Graph Observed
Data” option under the “Data” menu, many different combinations of plots can be
created by toggling on or off the buttons for each of the plots found at the bottom
of the window and then clicking on the “Redraw” button. For all of the graphs,
forecast data is displayed as blue lines, observed data is displayed as dark green
lines (with gusts, if available, as vertical red arrows), and guidance data (if it
exists for the forecast point) is displayed as purple lines. For each plotted line,
clicking with the left mouse button on the legend or legend line will toggle that
particular line on and off. If labels are displayed on any of the graph lines, these
may be toggled on and off by clicking on the legend or legend line using the right
mouse button. Note that at this time, no guidance data is available in Mverify for
sea height forecasts. On the graphical displays, an indicator box will appear at the
bottom just to the left of the “Redraw” button. This indicator box will show the
number of data elements on the left and the maximum allowed on the right, per
the MaxPlottedValues setting in the Mverify localization file, or the current
setting for this value from the “Options > Maximum Number of Labels” menu.
The following is a description of the six plots that are produced.

a) “1st Pd Wind Spd Plot” - This is a display of combinations of the first period
forecast wind speed with either the corresponding guidance or observed wind
speeds or both, depending on the menu choice from the “Analysis” menu. If all
plots are displayed, this is the second plot from the top.

b) “2nd Pd Wind Spd Plot” - This is a display of combinations of the second
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period forecast wind speed with either the corresponding guidance or observed
wind speeds or both, depending on the menu choice from the “Analysis” menu. If
all plots are displayed, this is the fourth plot from the top.

c¢) “1st Pd Wind Dir Plot” - This is a display of combinations of the first period
forecast wind direction with either the corresponding guidance or observed wind
directions or both, depending on the menu choice from the “Analysis” menu. If
all plots are displayed, this is the first plot at the top.

d) “2nd Pd Wind Dir Plot” - This is a display of combinations of the second
period forecast wind direction with either the corresponding guidance or observed
wind directions or both, depending on the menu choice from the “Analysis” menu.
If all plots are displayed, this is the third plot from the top.

e) “1st Pd Sea Ht Plot” - This is a display of the first period forecast sea height
with the corresponding observed sea height, depending on the menu choice from
the “Analysis” menu. If all plots are displayed, this is the fifth plot from the top.

f) “2nd Pd Sea Ht Plot” - This is a display of the second period forecast sea height
with the corresponding observed sea height, depending on the menu choice from
the “Analysis” menu. If all plots are displayed, this is the sixth (last) plot from the
top.

The “Forecast vs. Observed” submenu cascades to a choice for a listing or a
graph. The “List Comparison” and “Graph Comparison” menus are colored blue
and green respectively in order to make traversing the menus easier to follow.
From this menu, one selects the forecast point of interest to compare with
observed data. For the “List Comparison” selection, the forecast data for each
date is given along with the observed data that exactly matches the forecasted time
(either 18Z or 06Z). Both periods are shown. The “Graph Comparison” selection
provides a better comparison between forecast and observed data since all of the
available observed data in between the forecast data are displayed.

The “Forecast vs. Guidance” submenu cascades to the same choice for either a
listing or a graph, with the same color coding for ease of use. From this, one
selects the forecast point of interest to compare with the guidance data. Both
forecast periods are again shown in the “List Comparison” option. Note that for
either the “List Comparison” or the “Graph Comparison” selections, the guidance
data displayed will be from the guidance data that was available when the MVF
forecast product was issued. This will be from the 3™ and 5" periods of the
guidance with the same model run as the model data upon which the forecast was
based.

The “Forecast vs. Observed and Guidance” submenu cascades to a choice for a
listing or a graph. The “List Comparison” and “Graph Comparison” menus are
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colored blue and green respectively in order to make traversing the menus easier
to follow. From this menu, one selects the forecast point of interest to compare
with observed and guidance data. For the “List Comparison” selection, the
forecast data for each date is given along with the observed data that exactly
matches the forecasted time (either 18Z or 06Z). Both periods are shown. Again,
the “Graph Comparison” selection provides a better comparison between forecast
and observed data since all in between observed data observations are displayed.
As in the previous option (“Forecast vs. Guidance”), the guidance data displayed
will be from the guidance data that was available when the MVF forecast product
was issued. This will be from the 3™ and 5™ periods of the guidance with the
same model run as the model data upon which the forecast was based.

C) “Statistics” Menu

This menu has four main sections. For each of the first three sections, there are
three menus: “Forecast Point”, “Forecast Group”, and “All Forecast Points.” The
first of these (“Forecast Point”) displays a list of each of the individual forecast
points in the MVF product(s). The second of these (“Forecast Group™) is each set
of forecast points of each MVF product entry in the Mverify localization file.

The last of these (““All Forecast Points”) is all of the forecast points in all MVF
products combined into one listing. An office can produce statistics for individual
points or for all of the points that the office is forecasting for by using the first two
selections. The third selection is used for offices that are collecting a large
amount of forecast data, in order to produce regional or possibly national results.
For a detailed description of all of the data contained in this section and the
methodology for verification, see section 5, “Mverify General Statistics” and
section 6, “Myverify Advisory/Warning Statistics.” A section entitled “Adaptable
parameters used for these calculations” is included at the end of each statistics
product, and contains a listing of the value of each adaptable parameter found in
the “Advisory/Statistics Parameters” selection window.

The “Winds and Seas Only” submenu will produce the “General Statistics”
section and the “Wind Direction/Speed Performance Statistics” section. The
advantage to this menu option is that time is not spent processing the
advisory/warning verification, if that data is not desired.

The “Advisories Only” submenu will produce the “Advisory Statistics™ section
and the “Advisory Performance Statistics” sections. The advantage to this menu
option is that time is not spent processing the wind direction, speed and sea height
verification, if that data is not desired.

The “Winds, Seas and Advisories” submenu will produce the “General Statistics”,

“Wind Direction/Speed Performance Statistics”, “Advisory Statistics”, and the
“Advisory Performance Statistics” sections.
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The “Detailed Advisory Verification” submenu, valid only for a single forecast
point, will produce a special table that includes detailed information from the
advisory/warning verification algorithm for each forecast. Note that data for
hours of gust conditions will only be displayed if the “ConsiderGusts” flag is set
to “Y” in the Mverify localization file, or if the “Consider Gusts” option is
selected in the “Advisory/Statistics Parameters” window. This information will
be followed by an “Advisory Statistics” section, and an “Advisory Performance
Statistics” section, and finally by a table showing what adaptable parameters were
used in the calculations. The following table shows what types of information are
contained in the table, by column, starting from the left:

Column Label Field description

1 First Period Date First period date of the forecast

2 First Period Date First period hour of the forecast in UTC

3 Fest First period forecast advisory/warning code issued
in MVF product

4 Guid Rslt First period advisory/warning category, determined
from interpolation of guidance wind speed data

5 SC hrs First period hours of Small Craft Advisory

conditions found during interpolation of guidance
wind speed data

6 GL hrs First period hours of Gale Warning conditions
found during interpolation of guidance wind speed
data

7 ST hrs First period hours of Storm Warning conditions
found during interpolation of guidance wind speed
data

8 Obs Rslt First period advisory/warning category, determined
from observed data

9 SCw hrs First period hours of Small Craft Advisory
conditions satisfying the observed sustained wind
threshold

10 SCs hrs First period hours of Small Craft Advisory
conditions satisfying the observed sea height
threshold

11 SCg hrs First period hours of Small Craft Advisory
conditions satisfying the observed wind gust
threshold

12 GLw hrs First period hours of Gale Warning conditions
satisfying the observed sustained wind threshold

13 GLg hrs First period hours of Gale Warning conditions
satisfying the observed wind gust threshold

14 STw hrs First period hours of Storm Warning conditions
satisfying the observed sustained wind threshold
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16

17
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20

21

22

23

24

25

26

27

28

STg hrs
Fcst

Guid Rslt

SC hrs

GL hrs

ST hrs

Obs Rslt

SCw hrs

SCs hrs

SCg hrs

GLw hrs
GLg hrs
STw hrs

STg hrs

D) “Options” Menu

First period hours of Storm Warning conditions
satisfying the observed wind gust threshold
Second period forecast advisory/warning code
issued in MVF product

Second period advisory/warning category,
determined from interpolation of guidance wind
speed data

Second period hours of Small Craft Advisory
conditions found during interpolation of guidance
wind speed data

Second period hours of Gale Warning conditions
found during interpolation of guidance wind speed
data

Second period hours of Storm Warning conditions
found during interpolation of guidance wind speed
data

Second period advisory/warning category,
determined from observed data

Second period hours of Small Craft Advisory
conditions satisfying the observed sustained wind
threshold

Second period hours of Small Craft Advisory
conditions satisfying the observed sea height
threshold

Second period hours of Small Craft Advisory
conditions satisfying the observed wind gust
threshold

Second period hours of Gale Warning conditions
satisfying the observed sustained wind threshold
Second period hours of Gale Warning conditions
satisfying the observed wind gust threshold
Second period hours of Storm Warning conditions
satisfying the observed sustained wind threshold
Second period hours of Storm Warning conditions
satisfying the observed wind gust threshold

This is the most important menu in the Mverify GUI, as this menu allows for
powerful selection of data used in the “Data”, “Analysis” and “Statistics” menus.
The “Show All Dates (default)” submenu is the default when the Mverify GUI is
first started. If a range of dates is selected, then the default of all dates can be
returned by clicking on this selection.



I) The “Select Dates” submenu will open a window for selecting the date range.
The window contains six slider bars allowing for selection across a range of years,
months and days. The beginning year, month and day slider bars are at the top
and are in blue, while the ending year, month and day slider bars are at the bottom
and are in green. Note that a text readout near the bottom of the window displays
the range indicated by the slider bars. When this window is opened for the first
time, the beginning and ending date will be for the current day. Once a selection
is made, click on the “Accept Selection and Exit” button and the bottom left,
otherwise click on the “Discard Selection and Exit” button on the bottom right.

I) The “Show All Forecasters (default)” submenu is the default when the Mverify
GUTI is first started. If a specific forecaster is selected, then the default of all
forecasters can be returned by clicking on this selection. The “Select a
Forecaster” submenu will cascade to a listing of the available forecasters (from
the Mverify localization file).

III) The “Show Day and Night Issued Forecasts (default)” submenu is the default
when the Mverify GUI is first started. If a specific forecast issuance is selected,
then the default of all forecast issuances can be returned by clicking on this
selection. The “Select a Forecast Issuance” submenu cascades to two choices,
either “Day Forecasts” or “Night Forecasts.” The day forecasts were those issued
during the afternoon forecast shift, with the first valid time in the MVF product
being 06Z. The night forecasts were those issued during the nighttime forecast
shift, with the first valid time in the MVF product being 18Z.

IV) The “Advisory/Statistics Parameters” submenu opens a large window
allowing for the user to make temporary (only for that instance of the Mverify
GUI) changes to a number of parameters affecting the verification of winds, seas,
advisories and warnings. This window allows for the powerful ability to explore
different verification results using a multitude of adaptable parameters without
having to modify the Mverify localization file. More on these variables can be
found in section 4, “Mverify Configuration”, section 5, “Mverify General
Statistics” and section 6, “Mverify Advisory/Warning Statistics.” Note that once
changes are made in this window, they are effective immediately. In other words,
one does not need to click the “Done” button at the bottom to make the changes
take effect. The advantage of this is that the user can leave this window open
while running statistics. Clicking on the “Done” button will close the window,
and clicking on the “Defaults” button will return all of the settings to those in the
Mverify localization file. The window is broken up into three sections:

Section 1: “Global Verification Parameters” This section allows the following
selections (with descriptions following each):

a) A toggle between “Consider Gusts for Verification of
Advisories/Warnings” and “Don't Consider Gusts.” As per WSOM D-51,
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section 7.1 (page 31), frequent gusts above a given advisory/warning
threshold may require, in the forecaster's judgement, an advisory/warning
for that category. A station selecting to consider gusts (in addition to
sustained winds) for verification of advisories and warnings needs to have
the parameters for gusts set to suitable values in the Mverify localization
file (see section 4, “Mverify Configuration™).

b) A toggle between “Use Consecutive Duration for Verification of
Advisories/Warnings” and “Don't Use Consecutive Duration.” WSOM
D-51, section 7 (page 30) defines that the warnings and advisories apply to
conditions expected to persist for more than 2 hours. Whether or not this
period of time is to consist of consecutive observations or any sufficient
number of observations within a given period, is not clearly defined.
Therefore, this option provides the office with a means to verify by either
method. See section 6, “Mverify Advisory/Warning Statistics” and section
4, “Mverify Configuration” for some exceptions to the consecutive
duration setting.

¢) A slider bar for “Minimum Speed for Wind Direction Verification
(kts).” Since light winds typically result in variable wind directions, this
minimum speed is set so as not to penalize the forecaster for wind
direction errors in cases of light winds. At WFO Mobile, experience has
shown that a minimum of 6 knots is a good choice.

d) A slider bar for “Duration for Wind/Sea Verification (hrs).” This
powerful option allows for a variable amount of observations to be used to
average over for verifying the forecasted wind direction, wind speed and
sea height in the MVF product. The following table shows the effect that
each setting will have on the data used in the verification process:

Setting Data Range Used for Verification  Ex. for 18Z forecast
1 forecast hour 187

2 forecast hour and previous hour 17-18Z
3 hour before, valid hour and hour after 17-19Z
4 2 hours before, valid hour and 1 hour after 16-19Z
5 2 hours before, valid hour and 2 hours after 16-20Z
6 3 hours before, valid hour and 2 hours after 15-20Z
7 3 hours before, valid hour and 3 hours after 15-21Z
8 4 hours before, valid hour and 3 hours after 14-21Z
9 4 hours before, valid hour and 4 hours after 14-227
10 5 hours before, valid hour and 4 hours after 13-227
11 5 hours before, valid hour and 5 hours after 13-23Z
12 6 hours before, valid hour and 5 hours after 12-23Z
13 6 hours before, valid hour and 6 hours after 12-00Z
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This allows for offices to either follow the verification process that EMC
uses (5 hours of data centered on the forecast hour) or any other range,
such as just 1 hour, the data at the forecast hour. Although advantages
exist for many different settings, one advantage of just using the data at the
forecast hour (a value of 1) is that then information on timing and bias
(fast or slow with features such as fronts or land/sea breezes) will be
retained. Another advantage of using data just at the forecast hour is that a
comparison (although not as well defined) of the timing of guidance will
also be retained.

e) A slider bar for “Duration for Advisory Verification (hrs).” This is
another powerful option that allows for a variable amount of observations
to be used to verify the advisories and warnings in the MVF product. See
the table above for the effect that each setting will have on the verification
process. As an example, EMC averages the conditions during 5 hours
centered on the forecast hour and seeks out just one instance of winds or
seas that satisfies the national criteria for a given advisory or warning
threshold. The difficulty for a forecast office is that in the text of the
Coastal Waters Forecast (or Offshore Waters Forecast), an advisory or
warning is issued for the entire period, not just a five hour window. Note
that changing the duration of the advisory verification window affects the
duration criteria for each advisory and warning category. At WFO Mobile,
a 13 hour window is used with a 3 hour duration for each
advisory/warning category.

Section 2: “Sustained Wind Parameters”

a) A slider bar for “Minimum Small Craft Advisory Speed (kts).”
Adjustable from 10 to 40 knots. Other slider bars are affected such as the
“Minimum Small Craft Advisory Gust Speed (kts)”, “Minimum Gale
Warning Speed (kts)”, “Minimum Gale Warning Gust Speed (kts)”,
“Minimum Storm Warning Speed (kts)”, and “Minimum Storm Warning
Gust Speed (kts)” if the value is set high enough to cross any of these
thresholds.

b) A slider bar for “Minimum Small Craft Advisory Sea Height (ft).”
Adjustable from 0 to 20 feet.

c¢) A slider bar for “Minimum Gale Waming Speed (kts).” Adjustable
from 11 to 50 knots. Other slider bars are affected such as the “Minimum
Gale Warning Gust Speed (kts)”, “Minimum Storm Warning Speed (kts)”,
and “Minimum Storm Warning Gust Speed (kts)” if the value is set high
enough to cross any of these thresholds.

d) A slider bar for “Minimum Storm Warning Speed (kts)”, which is
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adjustable from 12 to 90 knots. The “Minimum Storm Waming Gust
Speed (kts)” slider bar will be affected if the value is set high enough to
cross that threshold.

e) A slider bar for “Minimum Small Craft Advisory Speed/Sea Duration
(obs).” Adjustable from 1 to 12 observations (note that this is
observations, not hours), but not to exceed a 13 hour window centered on
the forecast hour in the MVF product (such as 12-00Z for an 18Z forecast
hour or 00-12Z or a 06Z forecast hour). Note also that if the data in the
observed database for that period was not collected hourly, then a
non-consecutive duration will be used (just for that forecast!) even if the
ConsecutiveDuration was set to “Y.” See section 6, “Mverify
Advisory/Warning Statistics” and section 4, “Mverify Configuration” for
more on this.

f) A slider bar for “Minimum Gale Warning Speed Duration (obs).”
Adjustable from 1 to 12 observations. The same principles apply here as
for the “Minimum Small Craft Advisory Speed/Sea Duration.”

g) A slider bar for “Minimum Storm Warning Speed Duration (obs).”
Adjustable from 1 to 12 observations. The same principles apply here as
for the “Minimum Small Craft Advisory Speed/Sea Duration.”

Section 3: “Wind Gust Parameters”

a) A slider bar for “Minimum Small Craft Advisory Gust Speed (kts).”
Adjustable from 10 to 60 knots. Will only apply if “Consider Gusts for
Verification of Advisories/Warnings” is selected.

b) A slider bar for “Minimum Gale Warning Gust Speed (kts).”
Adjustable from 11 to 80 knots. Will only apply if “Consider Gusts for
Verification of Advisories/Warnings” is selected.

¢) A slider bar for “Minimum Storm Warning Gust Speed (kts).”
Adjustable from 12 to 120 knots. Will only apply if “Consider Gusts for
Verification of Advisories/Warnings” is selected.

d) A slider bar for “Minimum Small Craft Advisory Gust Duration (obs).”
Adjustable from 1 to 12 observations. The same principles apply here as
for the “Minimum Small Craft Advisory Speed/Sea Duration.” Will only
apply if “Consider Gusts for Verification of Advisories/Warnings” is
selected.

e) A slider bar for “Minimum Gale Warning Gust Duration (obs).”
Adjustable from 1 to 12 observations. The same principles apply here as
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for the “Minimum Small Craft Advisory Speed/Sea Duration.” Will only
apply if “Consider Gusts for Verification of Advisories/Warnings” is
selected.

f) A slider bar for “Minimum Storm Warning Gust Duration (obs).”
Adjustable from 1 to 12 observations. The same principles apply here as
for the “Minimum Small Craft Advisory Speed/Sea Duration.” Will only
apply if “Consider Gusts for Verification of Advisories/Warnings” is
selected.

V) The “Maximum Number of Labels” selection, which is the second selection
under the “Temporary Configuration Modifications” header, will open a window
with a slider bar for the maximum number of labels to be shown on the graphs (up
to 1500). Once a selection is made, click on the “Accept Selection and Exit”
button at the bottom left, otherwise click on the “Discard Selection and Exit”
button on the bottom right. Setting this value to 100 or more may make it difficult
to read some labels, but much higher settings will be desirable in some situations.

VI) The “Display Rejected Data” selection, under the “Data Quality Control”
header, will display a window that contains any data removed from consideration
by the Mverify GUI during any processing. The listing of rejected data in this
window will accumulate, so duplications may appear if several listings, graphs or
statistics have been generated. Forecast data errors are the most common due to
the hand coding by forecasters, and guidance errors are the least common. The
following are the types of checks performed on each data type, and the messages
that may appear in the “Display Rejected Data” window:

Forecast Data:

1) Check: Is the first period forecast hour either 06Z or 18Z? Error
message: Forecast first period hour error - (forecast data line)

2) Check: If the first period forecast hour is for 06Z, then does the second
period have the same date? Error message: Forecast second period hour
error - (forecast data line)

3) Check: If the first period forecast hour is for 18Z, then is the second
period for the next day? Error message: Forecast second period hour error
- (forecast data line)

4) Check: Does the first period advisory code contain either “NO”, “SC”,
“GL”, “ST”, “TS” or “HR”? Error message: Forecast first period advisory

code error - (forecast data line)

5) Check: Does the second period advisory code contain either “NO”,
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“SC”, “GL”, “ST”, “TS” or “HR”? Error message: Forecast second period
advisory code error - (forecast data line)

6) Check: Is the wind direction value between 0 and 36 in periods 1 and 2?
Error message: Forecast wind direction error/missing - (forecast data line)

7) Check: Does the wind speed value exist properly in periods 1 and 2?
Error message: Forecast wind speed missing - (forecast data line)

Guidance Data:

1) Check: Is the wind direction value between 0 and 36 in periods 3 and 5?
Error message: Guidance wind direction error/missing - (guidance data
line)

2) Check: Does the wind speed value exist properly in periods 3 and 5?
Error message: Guidance wind speed missing - (guidance data line)

Observed Data:

1) Check: Does the wind direction value exist properly? Error message:
Observed missing wind direction - (observed data line)

2) Check: Is the wind direction value between 0 and 36? Error message:
Observed wind direction error - (observed data line)

3) Check: Does the wind speed value exist properly? Error message:
Observed missing wind speed - (observed data line)

E) “Print” Menu

The “Print Display” submenu allows for the printing of either text listings or
graphs on either printer, but the graphs will only print in color on the Ip2 color
printer. The “Save Display to File” submenu is used for saving the display to a
file. The file name is not selectable, and will always be saved in the Mverify home
directory with the file name of “datafile”, but the extension will depend on the
type of data saved. Graphs will be saved as “datafile.ps” to indicate a PostScript
file, while the text listings will be saved as “datafile.txt.”

F) “Help” Menu

The help menu has three main choices. The first is “About Mverify 2.1", which
describes the software. The “View Configuration” choice will display the
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contents of the Mverify localization file. Note that while many of the parameters
can be changed (temporarily) from the “Advisory/Statistics Parameters” and
“Maximum Number of Labels” menu selections, such changes will not appear in
this display, as this is strictly a display of the Mverify localization file. Any
changes made under the “Advisory/Statistics Parameters” or “Maximum Number
of Labels” menu selections will not affect the Mverify localization file. More
information concerning the Mverify localization file can be found in section 4,
“Mverify Configuration.”

The “Choose a topic” submenu cascades to several help topic categories which
contain information that is very similar to this documentation. The ““Statistics >
Advisory/Warning Statistics” selection also contains flow charts for the statistical
processing which is not included in this documentation. The “Menu” selection is
covered in this portion of the documentation. The “Data” selection is covered in
section 3, “Mverify Data” which provides documentation on the types of data
used in Mverify, including the Mverify.perl data collection and database
maintenance program. The “Configuration” selection is covered in section 4,
“Mverify Configuration” which provides detailed guidance for the

Mverify localization file. The “Statistics > General Statistics” selection is
covered in section 5, “Mverify General Statistics” which provides an explanation
of all of the statistics calculated and displayed in the “General Statistics” and
“Wind Direction/Speed Performance Statistics” sections of a statistics report. The
“Statistics > Advisory/Warning Statistics” selection is covered in section 6,
“Mverify Advisory/Warning Statistics”, which provides a detailed explanation of
the algorithm used to verify advisories and warnings, including flow charts, as
well as the statistics provided in the “Advisory Statistics” and “Advisory
Performance Statistics” sections.

3) Data Used in Mverify

The data for Mverify 2.1 are collected by the Mverify.perl data collection and data base
management program which resides in the home directory of the Mverify Marine
Verification Program. Mverify.perl is usually configured to run on an hourly basis, but
can be run on a less frequent basis without the risk of lost data, as long as sufficient
versions of the needed data are stored in the AWIPS Informix database. The reason that
Mverify.perl can be run on a less frequent basis is that it extracts all of the versions for
each product currently contained in the AWIPS Informix database in order to complete its
task. There are several advantages to this, the most important of which is minimizing the
possibility of lost data. Once the Mverify Marine Verification Program has been set up
and the Mverify.perl program is run for the first time, it will generate the Observed,
Forecast and Guidance databases using what is currently stored in the AWIPS Informix
database. One can expect new Buoy/C-MAN data to be added to the Observed database
within an hour, with new MVF forecast data appearing within an hour after MVF product
issuance, and with the new guidance data arriving by roughly 06Z and 18Z, depending on
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model availability.

1. Observed Data

The observed data used by Mverify consists of C-MAN data and Buoy data as
specified in the Mverify localization file (see section 4, “Mverify Configuration”
for more information). The data collected are as follows, with the units of
measure included:

(1) station name,

(2) station latitude and longitude,

(3) wind direction,

(4) wind speed in knots,

(5) wind gust for the preceding hour in knots,

(6) air temperature in Fahrenheit,

(7) dew point temperature in Fahrenheit,

(8) water temperature in Fahrenheit,

(9) sea height in feet (utilizing the high resolution sea height, which is usually
available),

(10) sea period in seconds,

(11) station pressure in millibars,

(12) pressure tendency for the past three hours in millibars,
(13) tide in Mean Low Low Water (feet),

(14) visibility in statute miles.

Not all of these data elements will be available for each C-MAN or Buoy station.

2. Forecast Data

Forecast data is collected from the CCCMVFNNN product, as specified in the
Mverify localization file. The first period in the MVF product will be for either
06Z (a day shift issuance) or for 18Z (a night shift issuance). All of the
parameters in the MVF product are collected and decoded: the forecast wind
direction and speed in knots, any advisories/warnings and the forecasted sea
height in feet, all of which for the first and second periods.

3. Guidance Data
The guidance data is collected from the CCCMRPNNN product, as specified in
the Mverify localization file. This product contains eight periods of data at 6

hour intervals. All of the data is decoded and processed and can be viewed by
using the Mverify GUI, but only periods 2 through 6 (00Z, 06Z, 127, 18Z and

-16-



00Z) are used for the analysis and statistics in Mverify. For those interested in
where this guidance data comes from, it is derived from the NGM model.

4) Mverify Configuration

The configuration file for Mverify 2.1 is located in the home directory of the Mverify
Marine Verification Program and is entitled “Mverify localization.” Note that one may
make temporary changes to many of the parameters currently configured in the

Mverify localization file from the “Options” menu by selecting “Advisory/Statistics
Parameters” and/or “Maximum Number of Labels”, but these changes will not affect the
Mverify localization file itself.

Three data files are created by Mverify.perl (the data collection and database management
program) and updated as necessary as new data arrives. The Mverify 2.1.tcl program
(Mverify GUI) will access these files to produce the requested observed or derived
information. The three data files are:

(1) Observed (contains the observed data),
(2) Forecast (contains the forecast data),
(3) Guidance (contains the guidance data).

1. Observed Data Density

The first selection in the Mverify localization file is for whether to store the
Buoy/C-MAN data that is collected either hourly (strongly preferred), every 3
hours, or every 6 hours. Mverify will function best with the 1 hour (hourly)
setting as this will produce the most accurate results. Changing this number will
only make changes to future data collection: the data density previously collected
will not be affected. Note that while Mverify is capable of managing and using an
Observed data file that contains data collected at different intervals, this can affect
the way in which statistics are calculated. For this reason, it is recommended that
the data be collected hourly with version 2.x of Mverify, even if it was collected
every 3 hours (or less frequently) with version 1.0 of Mverify. The difficulties
mentioned above can be mitigated by choosing date selections that do not cross
the transition between hourly and less than hourly data, and also by making the
necessary adjustments to the duration of observation variables for each group, and
also making the correct selections for the “ObservedDataHours” and
“ObservedAdvisoryHours” variables in the Mverify localization file. Otherwise,
some forecast data may not be verified in precisely the manner expected. See
subsections 7 and 8, and section 6, “Mverify Advisory/Warning Statistics” for
more on this.
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2. C-MAN collective(s)

Each C-MAN collective to be used is specified in this section, followed by the
names of each of the station names desired to be displayed in the Mverify GUI
menus. The data collection program (Mverify.perl) will only collect the stations
listed here, even if others exist in the collective. The Mverify GUI will access this
section to set up the menus. Any number of collectives with any number of
stations may be specified.

3. Buoy collective(s)

Each Buoy collective to be used is specified in this section, followed by the names
of each of the station names desired to be displayed in the Mverity GUI menus.
Any number of Buoy collectives may be specified with any number of stations.
The data collection program (Mverify.perl) will only collect the stations listed
here, even if others exist in the collective. The Mverify GUI will access this
section to set up the menus.

4. Forecast product(s)

Each MVF forecast product to be used is specified here, followed by the names of
each of the stations contained in the MVF product. Any number of MVF products
may be specified. This entry will be used by both the Mverify data collection
program and the Mverify GUL

5. Forecaster names

Each of the forecasters who issue the MVF product need to be listed here. This
listing will be used for menus in the Mverify GUL

6. Guidance product(s)

Each MRP guidance product to be used is specified here. Any number of MVF
products may be specified with any number of stations, but watch out for
duplications! The data collection program (Mverify.perl) will only collect the
stations listed here, even if others exist in the guidance collective. Note also that
Myverify will only store the guidance stations that have MVF forecast points
(MVFname) listed in section 4. This is done in order to conserve disk space. If
one desires to store guidance data for points other than what is declared in section
4, then one can add the desired stations to one of the MVF product names, even
though the MVF product does not contain that forecast point. In this manner, one
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will “fool” Mverify into thinking that this is a valid forecast point. The Mverify
GUI will access this section to set up the menus pertaining to guidance locations.
Note that at this time, the following MRP guidance products can be decoded and
processed:

MRPCA2 (46023 and 46025 only)

MRPCWC (44012, 44004, 44009, CHLV2, DSLN7, 41001 and CLKN7 only)
MRPCWG

MRPCWN  (all except 18Z and BID)

MRPCWS

MRPCWW  (all except 53S and 87Q)

MRPGAK (46004, 46001 and 46003 only)

MRPPBW

MRPGLW  (see special decoder localization below)

MRPCBW  (TPLM2 only)

7. Special Localization for the MRPGLW Guidance

If the MRPGLW guidance is used, then list here each of the entries in the first
table in the MRPGLW guidance (wind forecast section), followed by the closest
Buoy or C-MAN station(s) of one’s choice. Note that more that one station may
be set to a particular guidance location, but the station must also be one of the
MVF forecast points, or else it will not be stored in the Guidance database (note
that one can “fool” Mverify using the method described in section 6). The
guidance entry will be stored as if it was for that/those station/stations. Omit the
entry if there is no matching Buoy or C-MAN station that one wants to use, or one
can set it to a station name that one makes up.

8. Advisory/Warning and Wind Direction Verification Parameters

This section contains a detailed description of the effects that each of the
parameters has on the verification of advisories and warnings and also for wind
direction verification (“MinWindSpeed” only). This first table shows the name of
the parameters in the Mverify localization file and the corresponding name shown
in the “Advisory/Statistics Parameters” window.

Mverify localization “Advisory/Statistics Parameters”

Parameter Names Slider and Toggle Names

ConsecutiveDuration “Use Consecutive Duration for Verification of
Advisories/Warnings” or “Don't Use Consecutive
Duration”
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ConsiderGusts

SmallCraftSpeedMin
SmallCraftSeaMin

SmallCraftDuration

SmallCraftGustMin

SmallCraftGustDuration

GaleSpeedMin
GaleDuration
GaleGustMin
GaleGustDuration
StormSpeedMin
StormDuration
StormGustMin
StormGustDuration

MinWindSpeed

“Consider Gusts for Verification of
Advisories/Warnings” or “Don't Consider Gusts”

“Minimum Small Craft Advisory Speed (kts)”
“Minimum Small Craft Advisory Sea Height (ft)”

“Minimum Small Craft Advisory Speed/Sea
Duration (obs)”

“Minimum Small Craft Advisory Gust Speed (kts)”

“Minimum Small Craft Advisory Gust Duration
(obs)”

“Minimum Gale Warning Speed (kts)”
“Minimum Gale Warning Speed Duration (obs)”
“Minimum Gale Warning Gust Speed (kts)”
“Minimum Gale Warning Gust Duration (obs)”
“Minimum Storm Warning Speed (kts)”
“Minimum Storm Warning Speed Duration (obs)”
“Minimum Storm Warning Gust Speed (kts)”
“Minimum Storm Warning Gust Duration (obs)”

“Minimum Speed for Wind Direction Verification
(kts)”

This next table shows the name of the parameters (from the Mverify localization
file for brevity), and a description followed by some examples:

Mverify localization
Parameter Name

ConsecutiveDuration

Description and Examples

“Y” indicates must have consecutive observations
satisfying verification thresholds. This will only
apply to data collected hourly. The algorithm that
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ConsiderGusts

SmallCraftSpeedMin

SmallCraftSeaMin

SmallCraftDuration

SmallCraftGustMin

SmallCraftGustDuration

GaleSpeedMin

GaleDuration

produces the verification statistics for advisories
and warnings will ignore the
“ConsecutiveDuration” flag if it determines that the
data is not hourly data. See the section 6, “Mverify
Advisory/Warning Statistics” for more on this.

“N” indicates that observations satisfying
verification thresholds do not need to be
consecutive.

“Y” indicates that gusts satisfying verification
thresholds for gusts will be used to verify advisories
and warnings. Verification by gusts is dependent
upon the “ConsecutiveDuration” flag. Note that
advisories/warnings will either be verified by a
sufficient number of sustained verifying winds or a
sufficient number of verifying gusts, but not a blend
of both.

“N” indicates that gusts will not be used for
verifying advisories and warnings.

Minimum sustained wind speed in knots for Small
Craft Advisories.

Minimum sea height in feet for Small Craft
Advisories.

Minimum number of observations with verifying
sustained wind speeds and/or sea heights required to
verify a Small Craft Advisory.

Minimum gust wind speed in knots for Small Craft
Advisories. Must have an entry even if gusts are
not used in the verification process.

Minimum number of observations with verifying
wind gust speeds required to verify a Small Craft
Advisory. Must have an entry even if gusts are not
used in the verification process.

Minimum sustained wind speed in knots for Gale
Warnings.

Minimum number of observations with verifying
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sustained wind speeds required to verify a Gale
Warning.

GaleGustMin Minimum gust wind speed in knots for Gale
Warnings. Must have an entry even if gusts are not
used in the verification process.

GaleGustDuration Minimum number of observations with verifying
wind gust speeds required to verify a Gale Warning.
Must have an entry even if gusts are not used in the
verification process.

StormSpeedMin Minimum sustained wind speed in knots for Storm
Warnings (includes TS and HR).

StormDuration Minimum number of observations with verifying
sustained wind speeds required to verify a Storm
Warning.

StormGustMin Minimum gust wind speed in knots for Storm

Warnings. Must have an entry even if gusts are not
used in the verification process.

StormGustDuration Minimum number of observations with verifying
wind gust speeds required to verify a Storm
Warning. Must have an entry even if gusts are not
used in the verification process.

MinWindSpeed Minimum observed wind speed to be used for
statistical calculations concerning wind direction.
This value is used to remove from consideration
light and variable wind events where wind direction
is very difficult to forecast.

Example #1: Suppose that data was collected hourly, and that observations at 13Z,
147 and 16Z had wind speeds (and/or seas) that satisfied the
“SmallCraftSpeedMin” (and/or “SmallCraftSeaMin”). If the
“ConsecutiveDuration” flag is set to “Y”” and the “SmallCraftDuration” is 3
observations, then this will not be sufficient to verify a Small Craft Advisory.
However, if the “ConsecutiveDuration” is set to “N”’ and the
“SmallCraftDuration” is 3 observations, then this would verify a Small Craft
Advisory. Note that for both of these cases, the “ObservedAdvisoryHours”
variable would have to be set to at least 11 to include consideration of the 13Z
observation.
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Example #2: Suppose that data was collected every 3 hours, and that observations
at 127, 157 and 21Z had wind speeds (and/or seas) that satisfied the
“SmallCraftSpeedMin” (and/or “SmallCraftSeaMin”) and the
“SmallCraftDuration” is set to 3 hours. Even if the “ConsecutiveDuration” flag is
set to “Y”, since the data was not collected hourly, this will be treated as if the
“ConsecutiveDuration” flag was set to “N”” and would thus verify a Small Craft
Advisory. The reason for this is to not make the verification too stringent for data
not collected hourly. Note that for this case, the “ObservedAdvisoryHours”
variable would have to be set to at least 12 to include consideration of the 127
observation.

Example #3: Suppose that data was collected hourly, and that observations at 20Z,
217 and 23Z had wind gusts that satisfied the “SmallCraftGustMin” and the
“SmallCraftGustDuration” is set to 3 observations. If the “ConsecutiveDuration”
flag is set to “Y”, then this would not verify a Small Craft Advisory. However, if
the “ConsecutiveDuration” flag is set to “N”, then this would verify a Small Craft
Advisory. Note that for both of these cases, the “ObservedAdvisoryHours”
variable would have to be set to at least 11 to include consideration of the 237
observation.

Example #4: Suppose that data was collected every 3 hours, and that observations
at 157, 217 and 00Z had wind gusts that satisfied the “SmallCraftGustMin” and
the “SmallCraftGustDuration” is 3 observations. Even if the
“ConsecutiveDuration” flag is set to “Y™, since the data was not collected hourly,
this will be treated as if the “ConsecutiveDuration” flag was set to “N”” and would
thus verify a Small Craft Advisory. The reason for this is to not make the
verification too stringent for data not collected hourly. Note that for this example,
the “ObservedAdvisoryHours” variable would have to be set to 13 (the maximum)
to include consideration of the 00Z observation.

Example #5: Suppose that data was collected hourly, and that observations at 12Z
and 21Z had wind gusts that satisfied the “SmallCraftGustMin” and the
“SmallCraftGustDuration” is 3 observations, and observations at 13Z and 14Z had
observed sustained winds (and/or seas) that satisfied the “SmallCraftSpeedMin”
(and/or SmallCraftSeaMin), and the “SmallCraftDuration” is 3 observations. If
the “ConsecutiveDuration” flag was set to “Y”” or “N”, then this would not satisfy
a Small Craft Advisory as neither the gust duration or the sustained winds/seas
duration of observations was met. Note that for this case, the
“ObservedAdvisoryHours” variable would have to be set to at least 12 to include
consideration of the 12Z observation.

9. Data Period of Consideration for Verification

This section contains a detailed description of the effects of the two parameters
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that control the hours used for verification of advisories and warnings and also for
wind direction, wind speed and sea height verification. This allows for offices to
either follow the verification process that EMC uses (5 hours of data centered on
the forecast hour) or any other range, such as just 1 hour, the data at the forecast
hour. This first table shows the name of the parameters in the

Mverify localization file and the corresponding name shown in the
“Advisory/Statistics Parameters” window.

Mverify localization “Advisory/Statistics Parameters”
Parameter Names Slider and Toggle Names
ObservedDataHours “Duration for Wind/Sea Verification (hrs)”

ObservedAdvisoryHours “Duration for Advisory Verification (hrs)”
This next table shows the names of the parameters (from the Mverify localization
file for brevity), and a description followed by some examples:

Mverify localization
Parameter Name Description and Examples

ObservedDataHours Specifies the number of hours used for the
verification of wind direction, wind speed and sea
height. See the next table for examples of the
effects of each setting. Although advantages exist
for many different settings, one advantage of just
using the data at the forecast hour (a value of 1) is
that then information on timing and bias (fast or
slow with features such as fronts or land/sea
breezes) will be retained. Another advantage of
using data just at the forecast hour is that a
comparison (although not as well defined) of the
timing of guidance data will also be retained. Note
that a simple average is performed for the sea
height, but for the wind direction and speed, a
vector average is determined.

ObservedAdvisoryHours Specifies the number of hours used for the
verification of advisories and warnings. See the
next table for examples of the effects of each
setting. This affects both the period of
consideration for the observed data, and also the
interpolation process of guidance wind speeds, if
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guidance data exists for the point(s) of interest.

The following table shows the effect that each setting will have on the data used
in the verification process:

Setting Data Range Used for Verification = Example for 18Z forecast
forecast hour 187

forecast hour and previous hour 17-18Z

hour before, valid hour and hour after 17-19Z

2 hours before, valid hour and 1 hour after 16-19Z

2 hours before, valid hour and 2 hours after 16-20Z

3 hours before, valid hour and 2 hours after 15-20Z

3 hours before, valid hour and 3 hours after 15-21Z

4 hours before, valid hour and 3 hours after 14-21Z

01N W B~ WDN =

9 4 hours before, valid hour and 4 hours after 14-227
10 5 hours before, valid hour and 4 hours after 13-227
11 5 hours before, valid hour and 5 hours after 13-23Z
12 6 hours before, valid hour and 5 hours after 12-23Z
13 6 hours before, valid hour and 6 hours after 12-00Z

10. Maximum Amount of Labels to be Shown on Graphs

The “MaxPlottedValues” variable in the Mverify localization file defines the
maximum number of labels that will be plotted on the graphs. This value can be
temporarily changed in the “Options > Maximum Number of Labels” selection.
This value should be set to 1500 or less. Typically, setting this value to less than
100 1s preferred, as larger values generally make the labels difficult to read due to
crowding, although sometimes much more labels will be desired.

5) Mverify General Statistics

The type of statistics used in Mverify were chosen by the author to serve a wide range of
interests, and range from simple means to statistics describing the shape of the sample
distribution, and robustness of the data. The statistics are grouped into four sections:
"General Statistics", "Wind Direction/Speed Performance Statistics", "Advisory
Statistics", and "Advisory Performance Statistics." This section covers the first two
sections, and the last two are covered in section 6, “Mverify Advisory/Warning
Statistics." A section entitled "Adaptable parameters used for these calculations" will be
included at the bottom of the statistics output and will contain the values of any adaptable
statistics parameters.
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I) General Statistics

In the "General Statistics" section, a number of statistics are produced for each
type of data, such as "Forecast Wind Direction", with columns for the first period,
second period, and both periods combined. The following is a short discussion of
the description and basic interpretation of each type of statistic. Concept of
"Error" used in the statistics: when one sees the word "Error" in the statistics, this
refers to the error between the forecast (or guidance) data and the observed value.
For example, if the forecast wind speed was 20 knots and the observed wind
speed was 10 knots, then the error would be (forecast minus observed) +10 knots.
Values closer to zero represent the least error.

1. Mean Error

This is the mean of the sample data, commonly known as the average. If
this value is not defined, it is set to 999.00. This value can be positive or
negative, and the significance of this is discussed for each data type:

For the wind direction error, this is the average error to the left or right of
the observed wind of the forecast or guidance data. A positive error
indicates that the forecast (or guidance) data was biased to the RIGHT of
the observed wind. A negative value indicates that the forecast/guidance
data was biased to the LEFT of the observed wind. For example: if the
mean error is 13.57, this means that the wind direction is, on average,
forecasted 13.57 degrees to the RIGHT of the observed wind.

For the wind speed error, this is the average error of the forecast (or
guidance) data compared to the observed data. A positive number
indicates that the forecast (guidance) data is typically too strong, while a
negative number indicates that the forecast (guidance) data is typically too
light. For example, if the mean error is 1.09, this means that the wind
speed is, on average, forecasted 1.09 knots above the observed wind.

For the sea height error, this is the average error of the forecast (guidance)
data compared to the observed data. A positive number indicates that the
forecast (guidance) data is typically too high, which a negative number
indicates that the forecast (guidance) data is typically too low. For
example, if the mean error is 0.32, this means that the sea height is, on
average, forecasted .32 feet above the observed value.

2. Mean Absolute Error
This is similar to the Mean Error, but different in that while determining

the error between the forecasted and observed value, the absolute value of
the error is used instead. This is sometimes more useful that the Mean
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Error in that this value ranges from zero on up, and will better indicate the
actual forecast error than the Mean Error. It has the disadvantage of not
being able to indicate whether the forecast error was below/above (or
RIGHT/LEFT) the observed data like the Mean Error statistic can.

This statistic is used later to make performance comparisons between the
guidance and forecast data due to the fact that it best represents the
forecast error and is rarely near zero. Ifthis value is not defined, it is set to
999.00.

3. Standard Deviation of the Mean Error

The standard deviation measures the spread or dispersion of the forecast
(guidance) errors. This is an important measure of how far the error
values are spread apart in the distribution. One can determine where the
bulk of scores are by using the standard deviation. One multiple of the
standard deviation will account for about 68% of the distribution, two
multiples of the standard deviation will account for about 95% of the
distribution, and three multiples will account for about 99% of the
distribution.

For example, a standard deviation of 41.56 for the wind direction error
means that 68% of all of the wind direction errors were +/- 41.56 of the
mean error. If this value cannot be computed, it will be set to -9.90.

4. Correlation Coefficient of the Forecast (or Guidance) to the Observed data

This measures the strength of the relationship between the forecast (or
guidance) data and the observed data. If this statistic cannot be
determined, it is reported as 9.99. This is different from the above values
in that it is NOT based upon the error but rather on the actual forecast (or
guidance) and observed data. This number can be negative or positive; a
negative correlation means that the forecast data tends to be opposite of
what the observed data was, while a positive correlation means that the
forecast data was in the same direction as the observed data.

If the correlation coefficient is +1, then the forecast (or guidance) data is
perfectly correlated with the observed data. If the correlation coefficient
is -1, then the forecast (or guidance) data is also perfectly correlated with
the observed data, but is also exactly opposite of the observed data:, i.e. if
the observed data trended downward, the forecast data was perfectly
trending upward. The best performance for the forecast (guidance) data
will be when the correlation coefficient is +1. This means that there was
no error between the forecast (guidance) data and the observed data, and
that the forecast (guidance) data was always increasing (or decreasing)
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when the observed data was increasing (or decreasing).
5. Skewness of Errors

This measures how skewed the distribution of forecast (or guidance) errors
are from the expected Gaussian distribution (more commonly known as
the bell curve). If all of the errors over all time were collected, it is a
central assumption of statistics that these errors will be normally
distributed such that if they were plotted, they would be in the shape of a
Gaussian distribution.

The Skewness measures how far to the left or right the distribution of
forecast (or guidance) errors is skewed from a Gaussian distribution. A
negative Skewness indicates that the distribution is skewed to the right,
while a positive Skewness indicates that the distribution is skewed to the
left.

It is important that enough data is available so that the statistics can be
relied upon to draw meteorological inferences. In order for this to be so,
the errors of forecast (guidance) data should fall roughly into the shape of
a Gaussian distribution, and the Skewness is a measure of this. Some
statisticians have said that if the Skewness is within +/- 2, then this is
within an acceptable range.

6. Kurtosis of Errors

This measures how peaked the distribution of forecast (or guidance) errors
are from the expected Gaussian distribution (more commonly known as
the bell curve). The Kurtosis measures how flat or more peaked the
distribution of forecast (or guidance) errors is compared to a Gaussian
distribution. A negative Kurtosis indicates that the distribution is flatter
(Platokurtic) than the Gaussian distribution, while a positive Kurtosis
indicates that the distribution is more peaked (Leptokurtic) than the
Gaussian distribution.

7. Chi-Square goodness of fit

This is the primary measure of whether the distribution of forecast (or
guidance) errors are distributed in a normal fashion. The Chi-Square value
given here is the sum of all the squared normalized differences between
the forecasted (or guidance or observed) data and then expected normal
distribution. The closer this value is to zero, the less of a difference that
the distribution has from a normal distribution. This statistic is compared
with a Chi-Square critical value for the next statistic.
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8. Pass Chi-Square test

This is the comparison between the Chi-Square goodness of fit statistic
and the Chi-Square critical value. For Mverify, the critical value is based
upon the .05 level of significance. If the result is "PASS", then this means
that with 95% certainty, we can be confident that the sample of data
resembles that of the expected population of data, while if it is "INSF
DATA" then the data likely does not come from a normal distribution.
Further, if the result is "PASS", then we can consider that all of the
statistics associated with this parameter (Forecast Wind Direction for
example), can be used with 95% confidence.

In general, one should only draw inferences from a particular type of data
(such as the Forecast Wind Direction) if the Chi-Square test is passed.
More advanced users can use the Chi-Square goodness of fit result to see
just how trustworthy the data really is.

9. Sample Size (# forecasts)

This is the number of forecast (or guidance) data that had matching
verifying observed data. Only forecast (or guidance) data that have
matching verifying data are used in the Mverify statistical calculations.

II) Wind Direction/Speed Performance Statistics

For the wind direction/speed performance statistics, each item is separated into a
result for the first period, then the second period, and finally for both periods
combined. If aresult cannot be computed, its value is set to 999.0%. Also, if
either the first or second period result is 999.0%, then the result for both periods
will also be 999.0%. Note that all of these comparisons are based upon the Mean
Absolute Error.

1. Improvement over Guidance Wind Direction

This shows the percentage improvement of the forecast wind direction
over the guidance wind direction, expressed as a percentage. A positive
value indicates improvement, while a negative value indicates deficient
performance. If the Chi-Square test statistic is passed for both the
guidance and forecast wind direction data, then the result for the Valid
Comparison will be "YES."

2. Improvement over Guidance Wind Speed

This shows the percentage improvement of the forecast wind speed over
the guidance wind speed, expressed as a percentage. A positive value
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indicates improvement, while a negative value indicates deficient
performance. If the Chi-Square test statistic is passed for both the
guidance and forecast wind speed data, then the result for the Valid
Comparison will be "YES."

3. Total Improvement over Guidance

This is the average percentage improvement of the forecast data over the
guidance data for the first, second and both periods. Positive values
indicate improvement, while negative values indicate deficient
performance. If the Chi-Square test statistic is passed for both the
guidance and forecast wind direction and wind speed data, then the result
for the Valid Comparison will be "YES."

6) Mverify Advisory/Warning Statistics

The statistics used in Mverify are grouped into four sections: "General Statistics", "Wind
Direction/Speed Performance Statistics", "Advisory Statistics", and "Advisory
Performance Statistics." This section covers the last two sections in a statistics report,
with the first two covered in section 5, "Mverify General Statistics." A section entitled
"Adaptable parameters used for these calculations" is included at the bottom of the
statistics output and contains the values of any adaptable statistics parameters.

I) Advisory Statistics

When either the "Advisories Only", "Winds, Seas and Advisories" or "Detailed
Advisory Verification" is chosen, then advisory/warning verification statistics are
included in the statistical output. Advisory/warning statistics are given for the
first period, second period and both periods combined. The formulas for the
Probability of Detection (POD - Equation 1), False Alarm Ratio (FAR - Equation
2) and Critical Success Index (CSI - Equation 3) are taken from WSOM C-75,
Appendix G (page G-3 through G-5). For these three equations, "A" is the
number of correctly forecasted events, "B" is the number of events that were not
forecasted, and "C" is the number of incorrect forecasts.

Equation 1 - POD:
A
POD = cccomeee
A+B
In other words, the POD is the fraction of correct forecasts compared to all

events. So, the POD is based upon events. A POD of 1 is a perfect score,
and 0 is the worst possible score.
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Equation 2 - FAR:

C
FAR = oo
A+C

In other words, the FAR is the fraction of incorrect forecasts compared to
all forecasts. So, the FAR is based upon forecasts. A FAR of 0 is a
perfect score, and a 1 is the worst score.

Equation 3 - CSI:

A
(O] (R —
A+B+C

In other words, the CSI is the fraction of correct forecasts compared to all
events and incorrect forecasts. A CSIof 1 is a perfect score and a 0 is the
worst score. The CSI is a measure of both the POD and FAR combined.

There are six groupings in the "Advisory Statistics" section, with the first for
human forecaster Small Craft Advisory verification, the second for guidance
Small Craft Advisory verification, the third for human forecaster Gale Warning
verification, the fourth for guidance Gale Warning verification, the fifth for
human forecaster Storm Warning verification, and the sixth for guidance Storm
Warning verification. In each of these groupings, the first line is for the POD, the
second line is for the FAR, and the third line is for the CSI, with each line
containing information for the first, second and both periods combined.

For the lines containing POD verification information, the parentheses contain the
number of correctly forecasted events divided by all events. For the lines
containing FAR verification information, the parentheses contain the number of
incorrect forecasts divided by all forecasts. For the lines containing the CSI
verification information, the parentheses contain the number of correct forecasts
divided by all events and incorrect forecasts.

1) Advisory Performance Statistics

The improvement over guidance statistics (if guidance is available) are given in
nearly the same manner as in the "Wind Direction/Speed Performance Statistics"
section, except that a valid comparison statement is not available. If sufficient
data for a comparison is not available, then the value will be set to 999.9%. There
are three groups: Small Craft Advisory improvement over guidance, Gale
Warning improvement over guidance, and Storm Warning improvement over
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guidance. Each of these groups has improvement statistics for the POD, FAR and

CSL

1) Guidance Advisory/Warning Category Determination

Interpolated guidance wind speed data, limited by the "ObservedAdvisoryHours"
setting in the Mverify localization file, is used to determine an advisory/warning
category for the guidance data. The following describes how the guidance data is
used in this process.

Step 1:

Step 2:

Step 3:

Interpolate the guidance data
First period Forecast Second period Forecast

Use guidance data for periods 2,3  Use guidance data for periods 3, 4
and 4 and interpolate in between and 5 and interpolate in between
these values. For example, for a these values. For example, for a
forecast centered on 18Z, use the forecast centered on 06Z, use the
127, 18Z and 00Z guidance data 00Z, 06Z and 12Z guidance and
and interpolate in between these interpolate in between these values.
values.

Use the hours of consideration

Use the "ObservedAdvisoryHours" setting to determine what hours are to
be considered for the determination of the guidance advisory/warning
category. This is done so that only interpolated guidance data in this
window is used to compare with the forecast values that were supposedly
based upon this same window of consideration.

Determine the guidance advisory/warning category

Step through the interpolated guidance data, limited by the
"ObservedAdvisoryHours" setting. For each piece of interpolated hourly
guidance data, determine which, if any, speed category (Small Craft
Advisory, Gale Warning or Storm Warning) the data falls within, and then
increment counters for that category as necessary. The determination of
these advisory/warning categories is dependent upon several adaptable
parameters from the Mverify localization file. These are:

- whether or not consecutive observations ("ConsecutiveDuration")
satisfying the respective speed/sea are necessary

- the hours of consideration are set by the "ObservedAdvisoryHours"
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variable.

- for a Small Craft Advisory, the sustained speed range is set by
"SmallCraftSpeedMin" and one less than "GaleSpeedMin" and must have
a duration of at least "SmallCraftDuration" observations.

- for a Gale Warning, the sustained speed range is set by "GaleSpeedMin"
and one less than "StormSpeedMin", and must have a duration of at least
"GaleDuration" observations.

- for a Storm Warning, the sustained speed must be at least
"StormSpeedMin" and must have a duration of at least "StormDuration"
observations.

Note that when the counters are to be incremented, any lesser advisory/warning
categories are also incremented. This is to preserve the verification of lesser
categories which may contain some observations that satisfy a higher warning
category. For example, if one hour of data had Small Craft Advisory conditions,
then the next hour had Gale Warmning conditions, then the next hour had Small
Craft Advisory conditions, then this would verify a Small Craft Advisory if the
duration for that category was three observations.

After the interpolated guidance data has been exhausted, check the counters for
each category to see if the duration has been satisfied for each respective category.
Note that the highest possible category is retained. While checking this, the
program first checks to see if the “ConsecutiveDuration” flag is set to “Y”” and
also if the previous condition flag for the given advisory/warning category is set to
“Y” as well. If these two conditions are met, then the counter for that category is
incremented. Otherwise, another check is performed to see if the
“ConsecutiveDuration” flag is set to “N”, in which case the counter for that
category is incremented. The “Advisory/Warning Statistics” section under the
Help tab in the Mverify GUI contains a flow chart of this process.

2) Observed Advisory/Warning Category Determination

Using the observed data, the proper advisory/warning category is determined,
which will be either "NO" for none, "SC" for Small Craft Advisory conditions,
"GL" for Gale Warning conditions, or "ST" for Storm Warning conditions. Note
that for Storm Warnings, Mverify treats a forecast for "ST" as the same as for
"TS" (tropical storm) and "HR" (hurricane). The determination of these
advisory/warning categories is dependent upon several adaptable parameters from
the Mverify localization file. These are:

- whether or not consecutive observations ("ConsecutiveDuration") satisfying the
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respective speed/sea are necessary
- whether or not to consider wind gusts ("ConsiderGusts")
- the hours of consideration are set by the "ObservedAdvisoryHours" variable.

- for a Small Craft Advisory, the sustained speed range is set by
"SmallCraftSpeedMin" and one less than "GaleSpeedMin", and the minimum sea
height is set by "SmallCraftSeaMin", and any combination of sustained winds or
seas must have a duration of at least "SmallCraftDuration" observations. If gusts
are considered, then the gust speed range is set by "SmallCraftGustMin" and one
less than "GaleGustMin" and must have a duration of at least
"SmallCraftGustDuration" observations.

- for a Gale Warning, the sustained speed range is set by "GaleSpeedMin" and one
less than "StormSpeedMin", and must have a duration of at least "GaleDuration"
observations. If gusts are considered, then the gust speed range is set by
"GaleGustMin" and one less than "StormGustMin" and must have a duration of at
least "GaleGustDuration" observations.

- for a Storm Warning, the sustained speed must be at least "StormSpeedMin" and
must have a duration of at least "StormDuration" observations. If gusts are
considered, then the gust speed must be at least "StormGustMin" and have a
duration of at least "StormGustDuration" observations.

This is a more complicated determination process due to the consideration of seas
and also the possible consideration of gusts. The "ObservedAdvisoryHours"
variable is used to determine what hours are to be considered for the
determination of the observed advisory/warning category. For each observation, it
is determined which, if any, speed category the data falls within, and then counters
for that category are incremented as necessary. Note that when the counters are to
be incremented, any lesser advisory/warning categories are also incremented.

This is to preserve the verification of lesser categories which may maintain some
observations that satisfy a higher warning category. For example, if one
observation had Gale Warning conditions, then the next observation had Storm
Warning conditions, then the next observation had Gale Warning conditions, then
this would verify a Gale Warning if the duration for that category was three
observations.

After the observed data has been exhausted, the counters for each category are
checked to see if the duration has been satisfied for each respective category.
Note that the highest possible category is retained and also that blends of
conditions satisfying gust conditions and sustained wind conditions are not
allowed to be combined to satisfy either sustained or gust conditions. If these
conditions are not met, then the program checks to see if the

34-



"ConsecutiveDuration" flag is set to "N" and the previous conditions flag for the
given advisory/warning category is set to "N" and the hourly data check is set to
"Y" and also if the counter for the given category is currently greater than or equal
to zero. If all of these are true, then set the counter for the given category to one.
The reason for setting the counter to one is twofold. First of all, if the
"ConsecutiveDuration" flag is set to "Y", then the program will not increment the
counter until the conditions have been met for at least two instances.

So, this will set the counter to one to count the first occurrence of the conditions.
The second purpose of this is to reset the counter back to one for the case in which
the counters for a given category have grown, but the conditions for that category
have not been consecutive. For example, given that the "ConsecutiveDuration"
flagis setto "Y", if one observation had Gale Warning conditions, then the next
observation had Small Craft Advisory conditions, then the next observation had
Gale Warning conditions, then the Gale Warning counter would indicate two
observations. Since a consecutive duration is indicated, then the Gale Warning
counter needs to be set back to one.

Lastly, a check is performed to see if the "ConsecutiveDuration" flag is set to "N"
or the hourly data check indicates that the data is not hourly. If either of these are
true, then the counter is incremented. In the case that the data is not required to be
consecutive, then the counter needs to be incremented. The reason that the
counter is incremented for data that is not hourly is that that data cannot be held to
consecutive data constraints due to the fact that there are gaps: the data was not
collected hourly.

3) Forecast and Guidance Advisory/Warning Verification

The process is identical for Small Craft Advisories and Gale Warnings. After all
of the data has been exhausted, then Equations 1, 2, and 3 are used to calculate the
POD, FAR and CSI for each of the advisory/warning categories for both the
human forecaster and guidance. Verification for the guidance data is only
performed where human forecast data exists. Note that the forecast for a given
category can only be verified by observed conditions in that category. For
example, if the forecast is for Small Craft Advisory conditions, then this can only
be verified with Small Craft Advisory conditions, and not with Gale Warning
conditions, etc. A flow chart for this process is included in the
“Advisory/Warning Statistics” section under the Help tab in the Mverify GUL
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